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Введение 

Современное образование переживает этап глубокой трансформации: от 

традиционной передачи знаний система движется к формированию у учащихся 

компетенций, востребованных в реальном секторе экономики. В условиях 

научно-технического прогресса особую значимость приобретает ранняя 

профориентация и развитие инженерного мышления у школьников. 

Реверсивный (обратный) инжиниринг — технология, изначально 

применявшаяся в промышленности для анализа и копирования изделий, — 

сегодня становится эффективным педагогическим инструментом. Её суть 

заключается в исследовании готового объекта с целью: 

 выявления принципов его работы; 

 анализа конструкции и материалов; 

 воссоздания технической документации (чертежей, 3D-моделей); 

 поиска возможностей для модернизации. 

В контексте предпрофильной подготовки (7–9-е классы) эта технология 

позволяет: 

 связать теоретические знания с практической деятельностью; 

 сформировать целостное представление о жизненном цикле изделия; 

 развить навыки проектной работы и критического анализа. 

Необходимость включения реверсивного инжиниринга в школьное 

образование продиктована рядом факторов: 

1. Кадровые потребности экономики. Согласно прогнозам 

Минэкономразвития РФ, к 2030 году спрос на инженерные кадры вырастет на 30 

- 40%. Раннее знакомство с инженерными методами повышает вероятность 

осознанного выбора технических специальностей. 

2. Требования ФГОС. Федеральные государственные образовательные 

стандарты основного общего образования акцентируют внимание на: 
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 развитии метапредметных навыков; 

 формировании исследовательских компетенций; 

 реализации практико-ориентированного обучения. 

3. Цифровая трансформация промышленности. Освоение инструментов 

реверсивного инжиниринга (3D-сканирование, CAD-моделирование) 

соответствует трендам Индустрии 4.0 и готовит учащихся к работе с 

современными технологиями (Рис. 1). 

 

Рис. 1. Индустрия 4.0 

4. Повышение мотивации. Работа с реальными объектами, которые можно 

разобрать, изучить и улучшить, делает обучение наглядным и увлекательным, 

снижая барьер между абстрактными знаниями и их применением. 
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Цели и задачи методических рекомендаций 

Цель — создать методический инструментарий для педагогов, 

позволяющий системно внедрять технологию реверсивного инжиниринга в 

образовательный процесс предпрофильных классов. 

Задачи: 

1. Раскрыть сущность и педагогические возможности реверсивного 

инжиниринга как образовательной технологии. 

2. Разработать поэтапную модель организации учебных проектов с учётом 

возрастных особенностей учащихся 13–15 лет. 

3. Определить критерии отбора объектов для анализа с учётом: 

 уровня сложности; 

 безопасности работ; 

 междисциплинарного потенциала. 

4. Сформировать комплекс дидактических материалов: 

 алгоритмы действий для учащихся; 

 шаблоны типовых ошибок; 

 правила техники безопасности. 

5. Описать способы интеграции технологии в учебные курсы: 

 технологии (трудовое обучение); 

 физики (изучение механизмов и законов); 

 математики (геометрические расчёты); 

 информатики (3D-моделирование, программирование). 

6. Разработать систему оценки результатов, включающую: 

 критерии качества выполненной работы; 

 формы фиксации достижений (портфолио проектов); 
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 методы рефлексии. 

Целевая аудитория 

Методические рекомендации адресованы: 

 учителям технологии, физики, математики и информатики; 

 педагогам дополнительного образования (технические кружки, STEM-

лаборатории); 

 методистам образовательных организаций; 

 кураторам предпрофильных классов и профориентационных программ; 

 администрациям школ, внедряющим инженерные треки обучения. 

Ожидаемые результаты внедрения 

Реализация предложенных методик позволит достичь следующих результатов: 

Для учащихся: 

 развитие пространственного и инженерного мышления; 

 формирование навыков работы с инструментами и цифровым 

оборудованием (3D-сканеры, CAD-программы, 3D-принтеры); 

 освоение основ проектной деятельности: от постановки задачи до 

презентации решения; 

 повышение мотивации к изучению технических дисциплин; 

 осознанный выбор профиля обучения в старших классах. 

Для педагогов: 

 расширение арсенала педагогических методов; 

 возможность интеграции междисциплинарного содержания; 

 создание базы учебных кейсов для дальнейшего использования. 

Для образовательной организации: 

 укрепление связей с индустриальными партнёрами; 
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 повышение престижа инженерных направлений; 

 соответствие трендам национального проекта «Образование». 

Материально-техническое обеспечение: 

 3D-сканер Range Vision Spectrum; 

 компьютер с установленным ПО: GOM Inspect, FreeCAD, Orca Slicer; 

 3D-принтер FullHeat от 3DQuality; 

 объекты для сканирования (простые детали с чёткими гранями и 

поверхностями); 

 расходные материалы для печати (PLA-пластик); 

 матирующий спрей (для блестящих поверхностей); 

Структура методических рекомендаций 

Документ включает следующие разделы: 

1. Теоретические основы реверсивного инжиниринга в образовании. 

2. Алгоритм организации учебного проекта (от выбора объекта до защиты 

результатов). 

3. Пример типовых заданий. 

4. Рекомендации по материально-техническому оснащению. 

5. Критерии оценки и формы фиксации достижений. 

Представленные материалы носят практико-ориентированный характер и 

могут быть адаптированы под специфику конкретной образовательной 

организации. Их реализация позволит сделать процесс предпрофильной 

подготовки более эффективным, а выбор будущей профессии — осознанным. 
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Этап 1. Анализ объектов проектирования 

Цель: изучить геометрию, функции и особенности объекта для 

последующего сканирования и моделирования. 

Задачи этапа: 

 выбрать объект для реверсивного инжиниринга (рекомендуются простые 

детали: шестерёнки, корпуса, крепёжные элементы); 

 провести визуальный осмотр: определить основные геометрические 

формы, выявить сложные элементы (отверстия, фаски, резьбы); 

 выполнить замеры ключевых размеров штангенциркулем или линейкой; 

 обсудить с учащимися возможные сложности при сканировании 

(блестящие/прозрачные поверхности, мелкие детали). 

Подробное описание действий 

1. Выбор объекта. Начните с деталей, состоящих из базовых 

геометрических форм (куб, цилиндр, конус). Примеры: пластиковая крышка, 

кронштейн, ручка. 

2. Визуальный анализ. Определите: 

 основные формы (плоскости, цилиндры, сферы); 

 функциональные элементы (резьбы, пазы, отверстия); 

 материал и цвет (влияют на сканирование). 

3. Замеры. Измерьте: 

 габаритные размеры (длина, ширина, высота); 

 диаметры отверстий и валов; 

 расстояния между элементами. 
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4. Планирование сканирования. Обсудите: 

 какие поверхности могут вызвать проблемы (блики, тени); 

 сколько ракурсов потребуется для полного охвата. 

Методические указания: 

 акцентируйте внимание на взаимосвязи формы и функции детали; 

 используйте эскизы для фиксации результатов анализа; 

 поощряйте вопросы учащихся о назначении элементов объекта. 

Ожидаемый результат: базовые габаритные размеры, план сканирования, 

список потенциальных сложностей. 

Практический пример 

В качестве примера выбора объекта проектирования взята рукоять рычага 

подъёмного механизма компьютерного стула «Brabix GM-305» кабинета 

информатики (Рис. 2). 

 

Рис. 2. Рукоять подъёмного рычага компьютерного стула 



10 
 

В результате эксплуатации у данных комплектующих вырабатываются 

некоторые структурные дефекты. Например, за счёт слишком мягкого пластика 

деформируется усадочное отверстие, рукояти не держатся на металлических 

рычагах-подъёмниках, в следствии чего образуется острая кромка рычага, 

способная нанести травму при невнимательном использовании (Рис. 3). 

 

Рис. 3. Дефекты и поломки рукояти рычага подъёмного механизма 

В результате анализа данный объект бы выбран для проектирования и 

разработан план сканирования: 

1. Откалибровать сканер на зону S. 

2. Подготовить изделие к сканированию. 

3. Нанести матирующий спрей. 

4. Произвести сканирование с 4 – 5 ракурсов с установкой 12 сканов на 

каждое положение. 

5. Сшить полученные группы сканов. 

6. Экспортировать модель объекта в формате *.stl. 
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Этап 2. 3D-сканирование 

В качестве сканирующего оборудования выбран комплект сканера Spectrum 

от компании RangeVision (Рис. 4). 

 

Рис. 4. Комплект сканера Spectrum от компании RangeVision 

Первые 3D-сканеры RangeVision выпустила на рынок в 2010 году. Уже к 

2015 году компания вошла в число крупнейших поставщиков профессиональных 

3D-сканеров в России, а до 2022 года сохраняла лидерство по экспорту, успешно 

продавая свою продукцию в 40 странах мира. 

Сканеры компании с успехом применяются по всему миру, находя свое 

место как на небольших предприятиях, так и в крупнейших корпорациях, 

включая лидеров своих отраслей, таких как Балтика, Hochland, Pirelli и Ferrari. 

На четырех континентах образовательные и научно-исследовательские 

учреждения активно используют наши сканеры в своей работе, доверяя их 

качеству и надежности. 
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Сегодня RangeVision остаётся ведущим разработчиком и поставщиком 3D-

сканеров и программного обеспечения к ним, осуществляя полный цикл 

разработки и производства в России.  

Линейка продукции RangeVision охватывает как доступные портативные, 

так и профессиональные ручные и стационарные 3D-сканеры, включая 

метрологические решения для самых разнообразных задач. Компания активно 

внедряет инновации, разрабатывая устройства с передовыми техническими 

характеристиками, которые не только соответствуют высоким требованиям 

рынка, но и обеспечивают удобство и простоту использования. 

В образовательные учреждения данные модели сканеров поставляются в 

рамках оборудования инженерных предпрофессиональных классов. Сканер 

имеет несколько положений камер, что позволяет оцифровывать объекты в 

широком габаритном диапазоне (Рис. 5). 

 

Рис. 5. Габаритные диапазоны сканируемых объектов 

Цель: получить точное цифровое облако точек объекта для дальнейшего 

моделирования. 

Задачи этапа: 

 подготовить объект к сканированию; 
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 откалибровать сканер; 

 выполнить сканирование с нескольких ракурсов; 

 сшить отдельные сканы в единую модель; 

 экспортировать данные в формате, совместимом с ПО для постобработки. 

Подготовительный этап 

1. Подготовка объекта: 

 очистите поверхность от загрязнений, пыли, жира; 

 для блестящих, зеркальных или прозрачных поверхностей нанесите 

матирующий спрей тонким равномерным слоем (дайте высохнуть 1 – 2 минуты); 

 если объект имеет сложные формы или мало характерных точек, наклейте 

маркеры (чёрно-белые круги диаметром 3 – 6 мм) — они помогут сканеру точнее 

совмещать ракурсы; 

 убедитесь, что объект неподвижен: закрепите его на поворотной 

платформе или устойчивой поверхности (Рис. 6). 

 

Рис. 6. Подготовленный к сканированию объект  
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2. Калибровка сканера: 

 разместите калибровочную пластину на рабочей поверхности 

поворотного стола согласно инструкции (Рис. 7); 

 

Рис. 7. Установка калибровочного поля, относительно сканера 

 запустите ПО RangeVision ScanCenter, выберите режим калибровки 

сканера на нужную зону (Рис. 8); 

 

Рис. 8. Запуск режима калибровки 
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 следуйте инструкциям программы: наведите камеру на калибровочные 

метки, дождитесь подтверждения успешного завершения; 

 сохраните профиль калибровки. 

Пример калибровки на зону S  

3. Настройка рабочего пространства: 

1. выберите помещение с равномерным освещением (избегайте прямых 

солнечных лучей и резких теней); 

2. убедитесь, что на фоне нет ярких объектов или движущихся элементов; 

3. установите сканер на устойчивую поверхность на расстоянии 0,3 – 0,5 м 

от объекта. 

Основной этап: сканирование 

1. Запуск ПО и создание проекта: 

1. откройте RangeVision ScanCenter; 

2. создайте новый проект на поворотном столе, укажите имя и путь 

сохранения; 

3. выберите режим сканирования: 

 Базовый — для простых объектов (разрешение 0,3–0,5 мм); 

 Точный — для деталей со сложной геометрией (0,1–0,2 мм); 

 Крупный объект — для габаритных деталей (автоматическая 

адаптация параметров). 

2. Позиционирование и предварительный обзор: 

 разместите объект в зоне видимости камер сканера (Рис. 9); 

 в интерфейсе ПО проверьте видимость объекта на обоих видеопотоках; 

https://edu.lookinengineering.ru/kalibrovka-skanera-rangevision-spectrum/kalibrovka-na-zonu-s/
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 при необходимости скорректируйте освещение или положение объекта. 

 

Рис. 9. Расположение объекта перед сканером 

3. Сканирование с разных ракурсов: 

 начните с фронтальной стороны, затем последовательно сканируйте 

боковые, верхнюю и нижнюю части (Рис. 10); 

 

Рис. 10. Выбор ракурсов для сканирования 
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 для полного охвата выполните 4 – 6 сканов с перекрытием зон на 20–30%; 

 во время сканирования: 

 не двигайте объект и сканер; 

 избегайте резких изменений освещения; 

 следите за индикатором качества (должен быть зелёным или жёлтым, 

красный сигнализирует о проблемах). 

4. Использование поворотной платформы (если доступна): 

1. закрепите объект на платформе; 

2. в ПО активируйте режим автоматического сканирования с поворотом; 

3. задайте количество шагов за оборот (рекомендуется 8 – 12); 

4. запустите процесс: платформа будет поворачивать объект, а сканер — 

фиксировать данные. 

Постобработка и экспорт 

1. Сшивка сканов: 

1. перейдите на вкладку Совмещение в ПО; 

2. нажмите Автоматически — программа попытается совместить сканы по 

общим точкам или маркерам; 

3. если автоматическое совмещение не удалось, выполните ручное: 

 выберите пару сканов; 

 укажите 3 – 4 совпадающие точки на каждом; 

 подтвердите выравнивание (Рис. 11); 

4. проверьте результат: модель должна быть цельной, без разрывов. 
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Рис. 11. Ручное совмещение групп сканов 

2. Очистка данных: 

1. перейдите на вкладку Обработка; 

2. удалите шумы и артефакты (Рис. 12): 

 используйте инструмент Удалить выбросы (убирает случайные 

точки вне объекта); 

 примените Заполнение дыр для небольших пропусков; 

 

Рис. 12. Удаление шумов и лишних артефактов на скане 
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3. Построение полигональной модели: 

1. на вкладке Модель выберите формат вывода: *.stl или *.ply; 

2. настройте плотность сетки (для учебных задач: 50 – 100 тыс. полигонов); 

3. нажмите Построить модель и дождитесь завершения процесса (Рис 13). 

 

Рис. 13. Построение модели 

4. Экспорт данных: 

1. перейдите на вкладку Экспорт; 

2. выберите формат: 

 *.stl — для дальнейшей работы в CAD-программах и 3D-печати; 

 *.ply — если нужно сохранить цветную текстуру; 

3. укажите папку для сохранения; 

4. назовите файл (например, Object_Scan_v1.stl). 
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Методические указания для преподавателя 

Что объяснить учащимся: 

 принцип работы сканера со структурированным светом (проекция полос, 

фиксация деформации); 

 влияние материала и цвета поверхности на качество сканирования; 

 важность перекрытия зон при многоракурсном сканировании; 

 роль маркеров в автоматическом совмещении сканов. 

В таблице представлены типовые ошибки, возникающие на этапе 

сканирования, и способы их решения (Таблица 1). 

Ошибка Причина Решение 

Пропуски в 

облаке точек 

Недостаточное 

освещение, блики 

Переместить объект в зону 

равномерного света, нанести 

матирующий спрей 

Разрывы 

между 

сканами 

Нехватка общих 

точек для 

совмещения 

Увеличить перекрытие зон, наклеить 

маркеры 

Шум 

(случайные 

точки) 

Вибрация, движение 

объекта 

Закрепить объект, исключить 

внешние воздействия 

Искажение 

геометрии 

Неправильная 

калибровка 

Повторить калибровку, проверить 

положение калибровочной пластины 

Таблица 1. Ошибки при сканировании и способы их решения 

Техника безопасности: 
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 при работе с матирующим спреем используйте перчатки и проветривайте 

помещение; 

 не направляйте объектив сканера на глаза; 

 следите за кабелями: исключите риск споткнуться или выдернуть разъём; 

 перед началом работы убедитесь, что оборудование заземлено. 

Ожидаемые результаты: 

 файл облака точек или полигональной сетки (*.stl/*.ply) с полным 

охватом поверхности объекта; 

 отсутствие пропусков и шумов в данных; 

 соответствие размеров модели реальному объекту (допуск: ±0,5 мм для 

учебных задач); 

 готовность файла к импорту в ПО для контроля (GOM Inspect) и 

моделирования (FreeCAD). 

Критерии оценки выполнения этапа: 

 полнота сканирования (все поверхности охвачены); 

 точность совмещения сканов (отсутствие разрывов); 

 корректность экспорта (файл открывается в целевом ПО); 

 соблюдение техники безопасности. 
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Этап 3. Контроль результатов сканирования 

В качестве ПО для контроля результатов сканирования выбрано 

приложение GOM Inspect 2018. Функционала бесплатной версии программы 

достаточно для выполнения необходимых задач. Данный этап используется в 

случае наличия дефектов на сканируемом объекте, или для снятия 

конструктивных показателей, для последующего импорта в CAD-систему и 

моделирования, с целью сравнения отсканированного и смоделированного 

объекта. 

Цель: проверить точность сканирования, выявить и исправить дефекты 

модели, убедиться в соответствии цифровой копии реальному объекту. 

Задачи этапа: 

 импортировать облако точек или полигональную модель; 

 провести визуальный и измерительный контроль качества данных; 

 сравнить скан с эталонными размерами или CAD-моделью; 

 проанализировать отклонения по всей поверхности; 

 устранить дефекты (пропуски, шум, артефакты); 

 экспортировать исправленную модель для дальнейшего моделирования. 

Подготовительный этап и контроль качества 

1. Запуск программы и создание проекта: 

 откройте GOM Inspect (Рис. 14); 

 создайте новый проект (File → New Project); 

 укажите имя проекта и папку для сохранения. 
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Рис. 14. Создание нового проекта в GOM Inspect 

2. Импорт данных: 

1. перейдите в меню File → Import; 

2. выберите файл облака точек или полигональной модели (*.stl, *.ply и 

т. д.); 

3. настройте параметры импорта (система координат, масштаб, единицы 

измерения) (Рис. 15). 

 

Рис. 15. Импорт результатов сканирования 
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Контроль качества 

1. Визуальная оценка модели: 

 используйте инструменты навигации для осмотра модели со всех сторон: 

 вращение (Rotate — зажатая левая кнопка мыши); 

 перемещение (Pan — зажатая средняя кнопка мыши); 

 масштабирование (Zoom — колёсико мыши); 

 проверьте: 

 полноту данных (отсутствие «дыр», разрывов); 

 плотность точек (равномерность покрытия); 

 наличие артефактов (лишних объектов, шумов). 

2. Измерение ключевых размеров: 

1. активируйте инструмент Distance (расстояние) или Diameter (диаметр); 

2. выберите точки или поверхности для измерения: 

 габаритные размеры (длина, ширина, высота); 

 диаметры отверстий и валов; 

 расстояния между элементами; 

3. сравните полученные значения с данными из этапа анализа объекта 

(допуск для учебных задач: ±0,5 мм); 

4. сохраните результаты измерений в отчёте (Report → Create Report). 
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Построение структурных элементов 

В случае последующего моделирования на основе отсканированного 

объекта выполняются дополнительные структурные построения (плоскости, 

сечения, точки, окружности и т.д.), которые будут доступны для импорта в CAD 

систему. 

В примере с рукоятью рычага подъёмного механизма компьютерного стула 

есть некорректно отсканированная зона – отверстие рукояти. Построим 

дополнительные элементы, для дальнейшей обработки в CAD-системе. 

1. Построение плоскости: 

1. Выделить все точки объекта комбинацией клавиш ctrl + A. 

2. Построить плоскость по трём точкам (Рис. 16). 

 

Рис. 16. Построение плоскости по трём точкам 

2. Построение сечения: 

1. Выделить все точки объекта комбинацией клавиш ctrl + A. 

2. Выбрать построение одного сечения. 

3. Построить сечение по одной из плоскостей (Рис. 17). 
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Рис. 17. Построение сечение по плоскости 

Для последующего импорта построений в CAD-систему необходимо 

экспортировать их, как геометрию в формате *.IGES: 

1. Выделить все созданные элементы в дереве построений. 

2. Экспортировать элементы, как геометрию *.IGES (Рис. 18). 

3. Сохранить объекты в отдельные файлы. 

 

Рис. 18. Экспорт дополнительной геометрии 
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Сравнение отсканированной и построенной модели 

При наличии построенной по снятым в GOM Inspect структурным элементам 

модели, есть возможность сравнения её с отсканированным объектом. 

1. если есть CAD-модель детали, импортируйте её в тот же проект (File → 

Import CAD); 

2. выровняйте скан и CAD-модель: 

 выберите Alignment → Best Fit Alignment; 

 укажите общие точки на обеих моделях (минимум 3); 

 подтвердите выравнивание; 

3. переключитесь в режим сравнения (Comparison → Surface Comparison). 

3. Анализ отклонений: 

1. настройте цветовую карту отклонений: 

 красный — превышение размеров (выступы); 

 синий — недостаток (углубления); 

 зелёный — соответствие эталону; 

2. задайте диапазон отклонений (для учебных задач: −1,0 мм…+1,0 мм); 

3. изучите карту: 

 выделите зоны с отклонениями более 0,5 мм; 

 определите причины (ошибки сканирования, деформации объекта); 

4. создайте отчёт по отклонениям (Report → Deviation Report). 
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Методические указания для преподавателя 

Что объяснить учащимся: 

 важность точности измерений: даже небольшие отклонения могут 

повлиять на сборку или функциональность детали; 

 принцип работы карты отклонений: цвет показывает величину и 

направление ошибки; 

 роль отчёта: документ подтверждает качество сканирования и 

исправлений; 

 связь между качеством сканирования и результатами постобработки. 

В таблице представлены типовые ошибки, возникающие на этапе 

сканирования, и способы их решения (Таблица 2). 

Ошибка Причина Решение 

Неполное 

выравнивание скана и 

CAD-модели 

Мало общих точек, 

неправильная 

выборка 

Добавьте точки 

выравнивания, проверьте 

систему координат 

Шум на карте 

отклонений 

Неудаленное облако 

точек, артефакты 

Примените Remove Outliers, 

увеличьте порог 

фильтрации 

Искажение геометрии 

при сглаживании 

Слишком высокая 

интенсивность 

фильтра 

Уменьшите количество 

итераций, работайте 

локально 

Пропуски не 

заполняются 

Сложная форма 

отверстия, недостаток 

данных 

Вручную выделите зону, 

выберите метод Flat или 

Smooth 

Таблица 2. Ошибки при работе в GOM Inspect и варианты их решения 
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Техника безопасности: 

 делайте резервные копии проекта перед внесением изменений; 

 следите за свободным местом на диске (большие облака точек занимают 

много памяти); 

 закрывайте другие программы для стабильной работы GOM Inspect. 

Ожидаемые результаты: 

 исправленный файл *.stl с полным охватом поверхности объекта; 

 соответствие размеров модели реальному объекту (допуск: ±0,5 мм); 

 карта отклонений преимущественно в зелёной зоне (отклонения <0,5 мм); 

 отчёт с измерениями и анализом качества; 

 готовность файла к импорту в FreeCAD для моделирования. 

Критерии оценки выполнения этапа: 

 полнота устранения дефектов (все пропуски и шумы удалены); 

 точность измерений (соответствие эталону); 

 корректность экспорта (файл открывается в FreeCAD); 

 качество отчёта (полнота данных, наглядность). 
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Этап 4. 3D-моделирование 

Для этапа моделирования рационально использовать кроссплатформенное 

свободное ПО FreeCAD. FreeCAD — это программа параметрического 

трёхмерного моделирования, предназначенная прежде всего для проектирования 

объектов реального мира любого размера. Параметрическое моделирование 

позволяет легко изменять ваш дизайн, возвращаясь к истории модели и изменяя 

её параметры. 

Программное обеспечение FreeCAD позволяет создавать параметрические 

двумерные эскизы геометрических фигур и использовать их в качестве базы для 

создания других объектов. Оно содержит множество инструментов, для 

подстройки размеров или извлечения подробностей дизайна из трёхмерных 

моделей для создания высококачественных чертежей готовых для производства. 

Цель: создать параметрическую 3D-модель на основе отсканированных 

данных, пригодную для дальнейшего использования (в т. ч. 3D-печати). 

Задачи этапа: 

 импортировать облако точек или полигональную модель; 

 преобразовать сетку в твёрдое тело; 

 проанализировать геометрию объекта; 

 построить параметрическую модель с помощью эскизов и операций; 

 проверить соответствие модели исходному объекту; 

 экспортировать модель в формате, совместимом с 3D-печатью. 

Импорт и построение параметрической модели 

1. Запуск программы и создание проекта: 

1. откройте FreeCAD; 

2. создайте новый файл (File → New); 
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3. сохраните проект (File → Save As), указав понятное имя (например, 

Object_Model_v1). 

2. Импорт отсканированной модели: 

1. перейдите в модуль Part Design; 

2. выберите File → Import; 

3. найдите файл *.stl или *.ply, полученный на этапе сканирования; 

4. нажмите Open — модель появится в рабочей области (Рис. 19). 

 

Рис. 19. Импорт модели в формате *.stl 

3. Визуальная оценка импортированной модели: 

1. используйте инструменты навигации для осмотра модели со всех сторон; 

2. проверьте: 

 полноту данных (отсутствие пропусков); 

 качество сетки (равномерность полигонов); 
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 ориентацию модели (при необходимости поверните её через 

Transform). 

Моделирование 

1. Преобразование сетки в твёрдое тело: 

1. переключитесь в модуль Part; 

2. выберите импортированную модель в дереве проекта; 

3. перейдите в меню Part → Create shape from mesh…; 

4. настройте допуск (для учебных задач: 0,1 мм); 

5. нажмите Create — появится новое твёрдое тело (Shape); 

6. удалите исходную сетку из дерева проекта (правой кнопкой мыши → 

Delete) (Рис. 20). 

 

Рис. 20. Преобразование *.stl в полигональную модель 

  



33 
 

2. Импорт дополнительной геометрии: 

1. выберите File → Import; 

2. укажите путь к экспортированной из GOM Inspect геометрии в формате 

*. IGES; 

3. перейти в режим создания эскиза в импортированной плоскости (Рис. 21) 

 

Рис. 21. Эскиз в импортированной дополнительной геометрии 

3. Построение эскиза: 

Для данного примера необходимо обработать отверстие рукояти, путём 

выреза цилиндрического отверстия, исключающее погрешности сканирования: 

4. перейти в режим эскиза в импортированной плоскости; 

5. создайте новый эскиз (Sketch → Create Sketch); 

6. построить окружность по внутреннему диаметру посадочного отверстия 

рукояти; 

7. вырезать по данной окружности отверстие в рукояти; 
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8. завершите эскиз (Close). 

9. упростите геометрию для 3D-печати (уберите мелкие детали, не 

влияющие на функцию). 

4. Экспорт модели: 

1. выберите твёрдое тело в дереве проекта; 

2. перейдите в File → Export; 

3. укажите формат: *.stl (стандарт для 3D-печати); 

4. настройте параметры экспорта: 

 единицы измерения: миллиметры; 

 линейное отклонение: 0,01 мм; 

 угловое отклонение: 0,5°; 

5. назовите файл (например, Object_Final.stl); 

6. сохраните в указанную папку (Рис. 22) 

 

Рис. 22. Экспорт отредактированной модели 
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Методические указания для преподавателя 

Что объяснить учащимся: 

 разницу между полигональной моделью (сеткой) и параметрической 

(твёрдым телом); 

 важность ограничений в эскизах: они фиксируют геометрию и позволяют 

легко вносить изменения; 

 принцип параметризации: изменение одного размера должно обновлять 

всю модель; 

 роль дерева проекта: оно отображает историю построения и позволяет 

редактировать шаги. 

В таблице представлены типовые ошибки, возникающие на этапе 

сканирования, и способы их решения (Таблица 3). 

Ошибка Причина Решение 

Эскиз не 

закрывается 

Несвязанные линии, 

разрывы контура 

Используйте Sketch → 

Validate Sketch для поиска 

ошибок, соедините точки 

Операция Pad не 

выполняется 

Незамкнутый контур, 

конфликтующие 

ограничения 

Проверьте эскиз, удалите 

лишние ограничения 

Модель имеет 

зазоры 

Неправильная 

последовательность 

операций 

Перестройте модель, 

используя Boolean для 

объединения тел 

Сетка при 

экспорте 

содержит дыры 

Незамкнутое твёрдое 

тело 

Проверьте модель в Mesh 

Design, закройте пропуски 
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Ошибка Причина Решение 

Размеры не 

соответствуют 

оригиналу 

Ошибки в измерениях 

или эскизе 

Перепроверьте размеры, 

отредактируйте эскиз 

Таблица 3. Ошибки при работе во FreeCAD и варианты их решения 

Техника безопасности: 

 сохраняйте проект каждые 10–15 минут (File → Save); 

 создавайте резервные копии файлов перед сложными операциями; 

 закрывайте другие программы для стабильной работы FreeCAD. 

Ожидаемые результаты: 

 параметрическая 3D-модель в формате *.stl, полностью соответствующая 

исходному объекту или улучшенная с учётом заданных требований; 

 дерево проекта с логичной последовательностью операций (эскизы, 

выдавливания, вырезы и т. д.); 

 отсутствие ошибок геометрии (разрывов, пересекающихся тел); 

 готовность файла к импорту в слайсер (Orca Slicer) для подготовки к 

печати. 

Критерии оценки выполнения этапа: 

 точность размеров (соответствие исходному объекту, допуск ±0,3 мм); 

 корректность параметризации (возможность изменить размер и обновить 

модель); 

 качество эскизов (замкнутость контуров, наличие ограничений); 

 чистота экспорта (файл открывается в Orca Slicer без ошибок); 
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Этап 4. Подготовка к 3D-печати 

Для подготовки к 3D-печати можно использовать различные слайсеры. В 

данных рекомендациях описывается процесс использования Orca Slicer, 

обладающим широким функционалом, обширным спектром доступных 

принтеров и гибкими настройками. 

Цель: преобразовать 3D-модель в набор команд для 3D-принтера (G-код), 

оптимизированный под конкретные условия печати. 

Задачи этапа: 

 импортировать 3D-модель в Orca Slicer; 

 позиционировать и масштабировать модель на виртуальном столе; 

 настроить параметры печати (материал, температура, скорость, 

заполнение и т. д.); 

 проанализировать модель в режиме предварительного просмотра; 

 сгенерировать G-код; 

 сохранить файл для передачи на 3D-принтер. 

Подготовительный этап 

1. Запуск программы и настройка профиля принтера: 

1. откройте Orca Slicer; 

2. в главном меню выберите Settings → Printer; 

3. найдите и выберите профиль принтера FullHeat (если его нет — создайте 

новый, указав: 

 область печати: 220×220×250 мм или согласно техническим 

характеристикам принтера; 

 диаметр сопла: 0,4 мм; 
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 наличие подогрева стола: да; 

 тип кинематики: Cartesian); 

4. сохраните настройки (Рис. 23) 

 

Рис. 23. Добавление нового принтера 

2. Создание или выбор профиля материала: 

1. перейдите в Settings → Filament; 

2. выберите готовый профиль PLA или создайте новый: 

 название: PLA Standard; 

 температура сопла: 190–210∘C; 

 температура стола: 50–60∘C; 

 скорость печати: 40–60 мм/с; 

 ретракт: включён (4–5 мм, 25–30 мм/с); 

 охлаждение: включено (100 % после 1-го слоя) (Рис. 24) 
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Рис. 24. Настройка филамента 

3. Выбор профиля процесса: 

1. перейдите в Settings → Process; 

2. выберите или создайте профиль Educational Print: 

 высота слоя: 0,2 мм (стандарт), 0,1 мм для высокой детализации; 

 толщина стенок: 0,8 мм (2× диаметр сопла); 

 заполнение: 20% (сетка или гироид); 

 количество верхних/нижних слоёв: 3; 

 поддержка: автоматическая (угол нависания 45∘); 

 юбка: 1 контур, расстояние 5 мм (Рис. 25). 
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Рис. 25. Настройка печати 

Настройка модели и генерация G-code 

1. Импорт модели: 

1. нажмите кнопку Import на панели инструментов или перетащите файл 

*.stl в рабочую область; 

2. дождитесь загрузки модели (она появится в центре стола); 

3. проверьте корректность отображения: нет разрывов, инвертированных 

нормалей. 

2. Позиционирование модели: 

 используйте инструмент Move (стрелка на панели), чтобы переместить 

модель на стол; 

 убедитесь, что она полностью находится в границах области печати 

(выделена рамкой); 

 при необходимости поверните модель (Rotate): 
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3. Настройка параметров печати: 

1. в правой панели выберите вкладку Print Settings; 

2. настройте ключевые параметры: 

 Quality: 

 высота слоя (Layer Height): 0,2 мм; 

 первый слой (First Layer Height): 0,3 мм; 

 ширина экструзии (Extrusion Width): автоматическая; 

 Infill: 

 плотность (Infill Density): 20%; 

 шаблон (Infill Pattern): сетка (Grid) или гироид (Gyroid); 

 частота изменения направления (Infill Angle): 45∘; 

 Support: 

 тип (Support Type): древовидный (Tree) или обычный (Normal); 

 зазор от модели (Support Z Gap): 0,1–0,2 мм; 

 угол нависания (Overhang Threshold): 45∘; 

 Speed: 

 общая (Print Speed): 50 мм/с; 

 первого слоя (First Layer Speed): 30 мм/с; 

 заполнения (Infill Speed): 60 мм/с; 

 Temperature: 

 сопло (Nozzle Temperature): 200∘C; 
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 стол (Bed Temperature): 60∘C; 

 Cooling: 

 вентилятор (Fan Speed): включён (100 % после 1-го слоя); 

 минимальный время слоя (Min Layer Time): 10 с. (Рис. 26) 

 

Рис. 26. Подготовка поддержки 

Генерация G-кода 

1. Анализ модели в режиме Preview: 

1. переключитесь на вкладку Preview; 

2. изучите слои: 

 первый слой должен плотно прилегать к столу; 

 поддержки должны касаться нависающих элементов; 

 заполнение равномерно распределено; 

3. используйте ползунок или клавиши со стрелками для прокрутки слоёв; 
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4. проверьте временные оценки (время печати, расход материала). 

2. Генерация G-кода: 

1. нажмите кнопку Slice Now; 

2. дождитесь завершения нарезки (статус отображается в нижней панели); 

3. программа покажет: 

 время печати (например, 2 ч 30 мин); 

 расход филамента (например, 15 г); 

 размер файла G-кода. 

3. Сохранение файла: 

1. выберите Export G-code; 

2. укажите путь сохранения (например, папка Prints); 

3. назовите файл понятно (например, Gear_v2_PLA_20pct.gcode); 

4. формат: *.gcode; 

5. нажмите Save. (Рис. 27) 

 

Рис. 27. Экспорт файла формата *.gcode 
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Методические указания для преподавателя 

Что объяснить учащимся: 

 влияние высоты слоя на качество и время печати (меньше слой — 

детальнее модель, но дольше печать); 

 роль поддержек: они нужны для нависаний более 45∘, но усложняют 

постобработку; 

 важность адгезии первого слоя: неправильные настройки приводят к 

отслоению; 

 связь скорости и качества: высокая скорость может вызвать вибрации и 

дефекты; 

 экономию материала: снижение заполнения до 10–15% для несиловых 

деталей. 

В таблице представлены типовые ошибки, возникающие на этапе 

сканирования, и способы их решения (Таблица 4). 

Ошибка Причина Решение 

Модель не помещается 

на столе 

Неверное 

масштабирование 
Уменьшите масштаб (например, до 80 %) 

Пропуски в заполнении 
Низкая плотность, высокая 

скорость 

Увеличьте Infill Density до 25%, снизьте 

скорость до 40 мм/с 

Отслоение первого слоя 
Плохая адгезия, холодный 

стол 

Включите Brim, повысьте температуру 

стола до 65∘C, очистите стол 

Поддержки не касаются 

модели 
Неверный угол нависания 

Снизите Overhang Threshold до 35∘, 

увеличьте Support Z Gap до 0,2 мм 

Таблица 4. Возможные ошибки при подготовке к 3D-печати и их решение 

Ожидаемый результат: готовый к печати файл формата *.gcode. 
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Этап 5. 3D-печать 

Для 3D-печати описан принтер Full Heat от компании 3DQuality.  

3DQuality одна из самых крупных российских компаний по разработке и 

производству 3D-оборудования. Производит надёжные, простые в 

использовании и доступные 3D-принтеры и 3D-сканеры для домашнего и 

коммерческого использования, над которыми трудятся лучшие разработчики.  

Компания является единственными российскими производителями 

Delta принтеров, отличающихся высокой точностью и скоростью печати, а также 

предоставляет полный спектр 3D- услуг и выполняет заказы любой сложности. 

Цель: изготовить физический прототип детали с заданными параметрами 

качества и точности. 

Задачи этапа: 

 подготовить принтер и расходные материалы; 

 загрузить G-код и запустить печать; 

 контролировать процесс печати; 

 извлечь и обработать готовую деталь; 

 проанализировать результат и выявить возможные ошибки. 

Подготовительный этап. Печать 

1. Проверка оборудования: 

 убедитесь, что принтер подключён к сети и включён (Рис. 28); 

 проверьте наличие свободного места на SD-карте или USB-накопителе 

(если используется); 

 осмотрите сопло: оно не должно быть засорено (при необходимости 

прочистите иглой или замените); 
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 проверьте натяжение ремней — они должны быть умеренно натянуты, без 

провисания. 

 

Рис. 28. Подготовка 3D-принтера перед печатью 

2. Подготовка стола: 

 очистите поверхность стола спиртом или обезжиривателем; 

 при необходимости нанесите адгезив (клей-карандаш, лак для волос или 

специальный спрей) (Рис. 29); 

 

Рис. 29. Подготовка стола принтера к печати 
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 выполните калибровку стола: 

 переведите принтер в ручной режим (Control → Move Axis); 

 установите сопло над каждым регулировочным винтом стола; 

 с помощью листа бумаги проверьте зазор: лист должен проходить с 

небольшим сопротивлением; 

 при необходимости отрегулируйте винты; 

 сохраните настройки калибровки. 

3. Загрузка материала: 

 установите катушку PLA-пластика на держатель; 

 заправьте нить в подающий механизм; 

 прогрейте сопло до 200∘C (Control → Preheat PLA); 

 вручную протолкните филамент до появления расплава; 

 отрежьте неровный конец нити (Рис. 30). 

 

Рис. 30. Установка и подготовка филамента 
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4. Загрузка G-кода: 

1. скопируйте файл *.gcode на SD-карту или USB-накопитель; 

2. вставьте носитель в принтер; 

3. в меню принтера выберите Print from SD или Print from USB (Рис. 31); 

4. найдите файл (например, Gear_v2_PLA_20pct.gcode) и выберите его. 

 

Рис. 31 Загрузка файла *.gcode 

Основной этап: запуск и контроль печати 

1. Запуск печати: 

1. выберите файл в меню принтера; 

2. нажмите Start или Print; 

3. дождитесь прогрева сопла (200∘C) и стола (60∘C); 

4. наблюдайте за первым слоем: пластик должен ложиться равномерно, без 

пропусков; 

5. Сопло экструдера не должно касаться стола. 
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2. Контроль первого слоя: 

 если пластик не прилипает: 

 остановите печать (Pause); 

 очистите стол и нанесите адгезив; 

 перезапустите печать; 

 если сопло слишком близко к столу: 

 скорректируйте Z-offset (Control → Motion → Z-offset); 

 уменьшите значение на 0,1 мм и перезапустите; 

 если нить идёт прерывисто: 

 проверьте подачу филамента; 

 убедитесь, что катушка вращается свободно. 

3. Мониторинг процесса: 

1. первые 10–15 минут — критический период: оставайтесь рядом (Рис. 32); 

 

Рис. 32. Промежуточный результат печати 
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2. проверяйте: 

 равномерность укладки слоёв; 

 отсутствие пропусков или смещений; 

 работу вентиляторов охлаждения (должны вращаться); 

 стабильность температуры (на дисплее принтера); 

3. каждые 30 минут осматривайте модель на предмет дефектов (Рис. 33): 

 отслоение краёв — увеличьте температуру стола до 65∘C; 

 вибрация — проверьте крепление принтера к поверхности; 

 

Рис. 33. Пример некорректного старта печати 

 паутина между элементами — проверьте настройки ретракта. 

4. Завершение печати: 

1. принтер подаст звуковой сигнал или завершит программу; 

2. отключите нагрев сопла и стола (Control → Cool Down); 

3. дождитесь остывания детали (5–10 мин). 
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Постобработка и анализ результата 

1. Извлечение детали: 

1. аккуратно подденьте край модели пластиковым шпателем; 

2. медленно отделите деталь от стола, избегая резких движений; 

3. если модель не снимается: 

 слегка согните стол (если гибкий); 

 используйте тонкий шпатель для поддевания; 

4. не применяйте металлические инструменты — они могут повредить 

покрытие стола. 

2. Удаление поддержек: 

 используйте кусачки или нож для срезания поддержек; 

 действуйте аккуратно: режьте у основания, не задевая поверхность 

модели; 

 для древовидных поддержек: отделяйте ветви по одной (Рис. 34). 

 

Рис. 34. Удаление поддержек с модели 
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3. Финишная обработка (по необходимости): 

 для сглаживания слоёв: 

 обработайте поверхность наждачной бумагой 600–1000; 

 нанесите полировочную пасту и отполируйте мягкой тканью; 

 для грунтовки под покраску: 

 обезжирьте модель спиртом; 

 нанесите аэрозольный грунт тонким слоем. 

Анализ качества и устранение ошибок 

1. Визуальная проверка: 

 оцените: 

 гладкость поверхности (отсутствие бугров, пропусков); 

 чёткость углов и граней; 

 плотность заполнения (можно слегка сжать деталь); 

 соответствие формы исходному объекту. 

2. Измерение размеров: 

 используйте штангенциркуль для проверки ключевых параметров: 

 диаметры отверстий и валов; 

 расстояния между элементами; 

 габаритные размеры. 

 сравните с моделью в FreeCAD (допуск для учебных задач: ±0,5 мм). 
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Методические указания для преподавателя 

Что объяснить учащимся: 

 важность калибровки стола: первый слой определяет успех всей печати; 

 роль адгезивов: они предотвращают отслоение, но требуют аккуратного 

нанесения; 

 влияние температуры: перегрев вызывает деформацию, недогрев — 

плохое сцепление; 

 необходимость контроля первых слоёв: ошибки на старте невозможно 

исправить позже; 

 технику безопасности: горячее сопло (200∘C), движущиеся части, 

проветривание помещения. 

Типичные ошибки и способы их устранения: 

Ошибка Причина Решение 

Отслоение 

краёв 

Холодный стол, плохая 

адгезия 

Повысьте температуру стола до 

65∘C, нанесите клей-карандаш 

Пропуски в 

слоях 

Засорение сопла, 

недостаточная подача 

пластика 

Прочистите сопло, проверьте 

натяжение подающего 

механизма 

Вибрация 

модели 

Нестабильное 

крепление принтера 

Установите принтер на ровную 

твёрдую поверхность, затяните 

болты 

Паутина 

между 

элементами 

Неправильные 

настройки ретракта 

Увеличьте длину ретракта до 

5 мм, скорость — до 30 мм/с 
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Ошибка Причина Решение 

Деформация 

углов 

Быстрое охлаждение, 

отсутствие брима 

Включите Brim (5 контуров), 

снизьте скорость печати до 

40 мм/с 

Неровные слои 
Износ ремней, люфт оси 

Z 

Проверьте натяжение ремней, 

смажьте направляющие оси Z 

Техника безопасности: 

 не касайтесь сопла и нагретого стола во время печати; 

 работайте в проветриваемом помещении (особенно при использовании 

ABS); 

 не оставляйте принтер без присмотра на длительное время; 

 отключайте питание при устранении серьёзных неисправностей. 

Ожидаемые результаты 

 готовая деталь, соответствующая исходной модели с допуском ±0,5 мм; 

 гладкая поверхность без дефектов (пропусков, паутины, отслоений); 

 корректная функциональность (если деталь подвижная или сборная); 

 отчёт с описанием процесса и выявленных ошибок; 

 навыки устранения типовых проблем 3D-печати. 

Критерии оценки выполнения этапа: 

 качество первого слоя (равномерность укладки); 

 точность размеров (соответствие FreeCAD-модели); 

 чистота постобработки (отсутствие следов поддержек); 

 соблюдение техники безопасности; 
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Интеграция реверсивного инжиниринга в учебный процесс 

Интеграция технологии реверсивного инжиниринга в учебный предмет 

«Технология» позволяет развивать у учащихся навыки анализа, моделирования, 

работы с современными технологиями и проектного мышления. Это 

способствует формированию технологической грамотности, подготовке к 

будущей профессиональной деятельности и адаптации к цифровому 

производству.  

Способы интеграции 

1. Теоретические занятия с изучением основ реверсивного 

инжиниринга. На уроках можно вводить понятие реверсивного инжиниринга 

(реверс-инжиниринга), объяснять его отличие от традиционного 

проектирования. Учащиеся знакомятся с целями, задачами и областями 

применения технологии (машиностроение, авиация, медицина, археология и 

др.). Можно использовать презентации, видеоматериалы, примеры из реальной 

практики.  

2. Практические работы с использованием 3D-сканеров и CAD-систем. 

Учащимся предлагают сканировать физические объекты с помощью 3D-

сканеров, а затем обрабатывать полученные данные в программах для 

компьютерного моделирования (например, Tinkercad, SketchUp, AutoCAD, 

SolidWorks). На этом этапе развиваются навыки работы с оборудованием и 

программным обеспечением, а также пространственное мышление.  

3. Проектная деятельность. Учащиеся работают над проектами, 

связанными с реверсивным инжинирингом. Например, они могут оцифровать 

какой-либо объект школьного пространства, восстановить утраченную 

документацию для старинной детали, разработать приспособление для 

бесконтактного открывания двери на основе отсканированной дверной ручки. 

Проекты могут быть групповыми, что развивает командную работу и 

коммуникативные навыки.  
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4. Решение ситуационных и комплексных задач. Реверсивный 

инжиниринг можно использовать как метод выполнения расчётных и 

графических работ. Например, учащимся предлагают проанализировать 

конструкцию существующего изделия, выявить его недостатки и предложить 

улучшения.  

5. Интеграция с другими дисциплинами. Реверсивный инжиниринг 

позволяет объединить знания из математики, информатики, географии, экологии 

и других предметов. Например, при работе над проектом можно учитывать 

экологические аспекты (оптимизация использования материалов, снижение 

отходов).  

6. Использование кейсов из реальной практики. Демонстрация 

практических примеров применения реверсивного инжиниринга (в 

автомобилестроении, аэрокосмической промышленности, реставрации 

артефактов и т. д.) помогает мотивировать учащихся и показать прикладную 

ценность технологии.  

7. Работа с ручным измерительным инструментом. Если нет доступа к 

3D-сканерам, учащиеся могут учиться измерять объекты штангенциркулем, 

линейкой и другими инструментами, а затем создавать модели на основе этих 

данных.  

8. Изучение этапов процесса. Можно структурировать обучение по этапам 

реверсивного инжиниринга: исследование объекта, получение данных 

(сканирование или ручное измерение), моделирование, интерпретация 

результатов и их применение.  

9. Подготовка к профессиональным стандартам и конкурсам. 

Интеграция реверсивного инжиниринга в учебный процесс может 

ориентировать учащихся на компетенции, соответствующие стандартам 

WorldSkills (например, «Инженерный дизайн CAD», «Реверсивный 

инжиниринг»).  
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10. Использование цифровых образовательных ресурсов. Онлайн-

платформы, видеоуроки, интерактивные задания помогут углубить знания и 

предоставить дополнительные возможности для практики.  

Ожидаемые результаты: 

 Знания: понятие реверсивного инжиниринга, его цели и области 

применения, этапы процесса, типы оборудования и программного обеспечения. 

 Умения: работать с 3D-сканерами и CAD-системами, анализировать 

конструкции, создавать цифровые модели, готовить техническую 

документацию. 

 Навыки: проектного мышления, пространственного анализа, работы в 

команде, использования информационных технологий в производственных 

задачах. 

 Развитие: творческого подхода, инженерного мышления, мотивации к 

изучению современных технологий.  

При внедрении реверсивного инжиниринга в учебный процесс важно 

учитывать материально-технические возможности школы, уровень подготовки 

учащихся и требования образовательных стандартов. 
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Заключение и перспективы развития 

В ходе разработки методических рекомендаций по использованию 

технологии реверсивного инжиниринга в предпрофильных классах (7–9-е 

классы) была доказана высокая эффективность данного подхода для решения 

ключевых задач современного образования. 

Основные итоги реализации технологии: 

1. Интеграция теории и практики. Реверсивный инжиниринг позволяет 

учащимся не просто изучать абстрактные законы физики или геометрии, но и 

видеть их применение в реальных конструкциях. Например, анализ зубчатой 

передачи даёт возможность на практике изучить принципы механики, а разбор 

электронного устройства — понять основы электротехники. 

2. Развитие метапредметных компетенций. В процессе работы над 

проектами школьники: 

 учатся ставить цели и планировать этапы решения задачи; 

 осваивают навыки работы с измерительными инструментами и 

цифровым оборудованием (3D-сканерами, CAD-программами); 

 развивают пространственное мышление через создание чертежей и 

3D-моделей; 

 формируют коммуникативные навыки при защите проектов и 

коллективной работе. 

3. Профориентационный эффект. Погружение в инженерную 

деятельность на доступном уровне помогает учащимся: 

 выявить интерес к техническим специальностям; 
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 оценить свои способности к конструкторской и исследовательской 

работе; 

 сделать осознанный выбор профиля обучения в старших классах. 

4. Мотивация к обучению. Работа с реальными объектами, которые 

можно разобрать, изучить и усовершенствовать, делает образовательный 

процесс увлекательным и значимым. Это особенно важно для подростков 13–

15 лет, которым сложно удерживать внимание на абстрактных темах. 

5. Соответствие образовательным стандартам. Технология 

реверсивного инжиниринга полностью отвечает требованиям ФГОС ООО, 

поскольку: 

 развивает универсальные учебные действия; 

 реализует проектный и исследовательский подходы; 

 способствует формированию функциональной грамотности. 

6. Формирование культуры безопасной работы. В ходе выполнения 

заданий учащиеся осваивают правила техники безопасности при работе с 

инструментами, оборудованием и материалами, что является важным элементом 

трудового воспитания. 

7. Развитие критического мышления. Анализ конструкции изделия 

требует выдвижения гипотез, проверки их на практике, выявления 

причинно-следственных связей и поиска оптимальных решений. 

 

Перспективы развития 

Внедрение реверсивного инжиниринга в предпрофильную подготовку 

открывает широкие возможности для дальнейшего развития образовательного 

процесса: 
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1. Расширение материально-технической базы: 

 оснащение учебных мастерских 3D-принтерами и 3D-сканерами для 

полного цикла «анализ → моделирование → изготовление»; 

 внедрение VR/AR-технологий для виртуального разбора сложных 

устройств; 

 создание цифровых библиотек отсканированных объектов для 

использования в учебных проектах. 

2. Углубление междисциплинарных связей: 

 интеграция с курсами робототехники (анализ конструкций роботов); 

 связь с химией (изучение свойств материалов, из которых изготовлены 

детали); 

 взаимодействие с биологией (бионика: исследование природных 

прототипов инженерных решений). 

3. Развитие сетевых форм взаимодействия: 

 партнёрство с техническими вузами для проведения мастер-классов и 

консультаций; 

 сотрудничество с предприятиями для анализа реальных промышленных 

изделий; 

 организация межшкольных конкурсов проектов по реверсивному 

инжинирингу. 

4. Цифровая трансформация методики: 

 использование облачных платформ для совместной работы над 

3D-моделями; 
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 внедрение систем автоматизированного проектирования начального 

уровня (например, Tinkercad, FreeCAD); 

 создание онлайн-курсов и видеоинструкций для самостоятельной работы 

учащихся. 

5. Дифференциация обучения: 

 разработка заданий разного уровня сложности — от анализа простых 

механических устройств (дверные петли, зажимы) до изучения электронных 

гаджетов (наушники, пульты); 

 создание индивидуальных образовательных маршрутов для одарённых 

школьников; 

 включение элементов реверсивного инжиниринга в программы 

дополнительного образования (кружки, факультативы). 

6. Научно-методическое сопровождение: 

 проведение педагогических исследований по оценке эффективности 

технологии; 

 публикация методических сборников с лучшими кейсами; 

 организация семинаров и вебинаров для обмена опытом между 

учителями. 

7. Масштабирование практики: 

 тиражирование опыта на уровне муниципальных и региональных 

образовательных систем; 

 включение реверсивного инжиниринга в программы предпрофильной 

подготовки других регионов; 
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Вывод 

Технология реверсивного инжиниринга доказала свою эффективность как 

инструмент предпрофильной подготовки школьников. Её систематическое 

применение не только повышает качество образования, но и способствует 

формированию инженерного мышления, развитию творческих способностей и 

осознанному выбору будущей профессии. Дальнейшее развитие этой методики 

требует консолидации усилий педагогов, методистов, представителей науки и 

промышленности. Реализация предложенных перспектив позволит вывести 

предпрофильную инженерную подготовку на качественно новый уровень и 

внести вклад в решение стратегической задачи — обеспечение экономики 

квалифицированными техническими кадрами. 
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